
Chapter 15

Defining Block Attributes

After completing this chapter, you will be able to:
• Understand what attributes are and how to define them with a block.
• Edit attribute tag names.
• Insert blocks with attributes and assign values to attributes.
• Extract attribute values from the inserted blocks.
• Control attribute visibility.
• Perform global and individual editing of attributes.
• Insert a text file in a drawing to create bill of material.

Learning Objectives
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Menu: Draw > Block > Define Attributes
Command: ATTDEF

UNDERSTANDING ATTRIBUTES
AutoCAD LT has provided a facility that allows the user to attach information to blocks. This
information can then be retrieved and processed by other programs for various purposes. For
example, you can use this information to create a bill of material for a project, find the total
number of computers in a building, or determine the location of each block in a drawing.
Attributes can also be used to create blocks (such as title blocks) with prompted or preformatted
text, to control text placement. The information associated with a block is known as attribute
value or simply attribute. AutoCAD LT references the attributes with a block through tag names.

Before assigning attributes to a block, you must create an attribute definition by using the  ATTDEF
command. The attribute definition describes the characteristics of the attribute. You can define
several attribute definitions (tags) and include them in the block definition. Each time you insert
the block, AutoCAD LT will prompt you to enter the value of the attribute. The attribute value
automatically replaces the attribute tag name. The information (attribute values) assigned to a
block can be extracted and written to a file by using AutoCAD LT’s ATTEXT command. This
file can then be inserted in the drawing as a table or processed by other programs to analyze the
data. The attribute values can be edited by using the ATTEDIT command. The display of
attributes can be controlled with the ATTDISP command.

DEFINING ATTRIBUTES

When you invoke the ATTDEF command, the Attribute Definition dialog box is displayed, see
Figure 15-1. The block attributes can be defined through this dialog box. When creating an
attribute definition, you must define the mode, attributes, insertion point, and text information
for each attribute. All this information can be entered in the dialog box. The following is the
description of each area of the Attribute Definition dialog box.

Mode Area
The Mode area of the Attribute Definition dialog box has four check boxes: Invisible, Constant,
Verify and, Preset. These determine the display and edit features of the block attributes. For
example, if you select the Invisible check box, the attribute becomes invisible; that is, it is not
displayed on the screen. Similarly, if the Constant check box is selected, the attribute becomes
constant. This means that its value is predefined and cannot be changed. These options are
described next.

Invisible
This option lets you create an attribute that is not visible on the screen, by default. Clear this
check box if you want the attribute to be visible.
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Tip
The Invisible mode is especially useful when you do not want the attribute values to be
displayed on the screen to avoid cluttering the drawing. Also, if the attributes are invisible, it
takes less time to regenerate the drawing.

You can make the invisible attribute visible by using the ATTDISP command discussed later in
this chapter, in the section “Controlling Attribute Visibility”.

Constant
This option lets you create an attribute that has a fixed value and cannot be changed after block
insertion. When you select this mode, the Prompt edit box and the Verify and Preset check
boxes are disabled. Since the value is constant, there is no need to be prompted for new values.
This check box is cleared by default and you can use different attribute values for the blocks.

Verify
This option allows you to verify the attribute value you have entered when inserting a block by
asking you twice for the data. If the value is incorrect, you can correct it by entering the new
value. If this check box is cleared, you are not prompted for verification of the attribute values.

Preset
This option allows you to create an attribute that is automatically set to the default value. The
attribute values are not requested when you insert a block and the default values are used. But
unlike a constant attribute, the preset attribute value can be edited later.

Figure 15-1  The Attribute Definition dialog box
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Note
Not selecting any of the check boxes in the Mode area displays all the prompts at the command
line and the values will be visible on the screen. This is also referred to as the Normal mode.

Attribute Area
The Attribute area (Figure 15-2) of the Attribute
Definition dialog box  has three edit boxes: Tag,
Prompt, and Value, where you can enter values. You
can enter up to 256 characters in these edit boxes. If the
first character to be entered in any one of these edit
boxes is a space, you should start with a backslash (\).
But if the first character is a backslash (\), you should
start the value to be entered with two backslashes (\\).
The three edit boxes have been described next.

Tag
This is like a label that is used to identify an attribute. For example, the tag name COMPUTER
can be used to identify an item. Here you can enter the tag names as uppercase, lowercase, or
both, but all lowercase letters are automatically converted into uppercase when displayed. The
tag name cannot be null. Also, it must not contain any blank spaces.

Tip
It is advisable to specify a tag name that reflects the contents of the item being tagged. For
example, the tag name COMP or COMPUTER is an appropriate name for labeling computers.

Prompt
The text that you enter in the Prompt edit box is used as a prompt when you insert a block that
contains the defined attribute. For example, if COMPUTER is the tag, you can enter WHAT IS
THE MEMORY? or ENTER MEMORY: in the Prompt edit box.  AutoCAD LT will then prompt
you with this same statement when you insert the block with which the attribute is defined. If you
have selected the Constant check box in the Mode area, the Prompt edit box is not available
because no prompt is required if the attribute is constant. If you do not enter anything in the
Prompt edit box, the entry made in the Tag edit box is used as the prompt.

Value
The entry in the Value edit box defines the default value of the specified attribute. If you do not
enter a value, it is used as the value for the attribute. The entry of a value is optional.

Insert field
This button is chosen to insert a field as the value of the attribute. When you choose this button,
the Field dialog box is displayed that can be used to insert the required field.

Insertion Point Area
The Insertion Point area of the Attribute Definition dialog box (Figure 15-3) lets you define the

Figure 15-2  The Attribute area of the
Attribute Definition dialog box
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insertion point of the block attribute text. You can define
the insertion point by entering the values in the X, Y, and
Z edit boxes or by specifying it on the screen. To specify
the insertion point on the screen, select the Specify
On-Screen check box. Now, set the parameters in all the
other fields and areas and then choose OK. You will be
prompted to select the Start Point of the attribute.

Just below the Insertion Point area of the dialog box is a
check box labeled Align below previous attribute
definition. This check box is not available when you use
the Attribute Definition dialog box for the first time. After you have defined an attribute and
when you press ENTER to display the Attribute Definition dialog box again, this check box is
available. You can select this check box to place the subsequent attribute text just below the
previously defined attribute automatically. When you select this check box, the Insertion Point
area and the Text Options areas of the dialog box are not available and AutoCAD LT assumes
previously defined values for text such as text height, text style, text justification, and text
rotation. The text is automatically placed on the following line.

Text Options Area
The Text Options area of the Attribute Definition dialog
box (Figure 15-4) lets you define the justification, text style,
height, and rotation of the attribute text. To set the text
justification, select a justification type from the Justification
drop-down list. The default option is Left. Similarly, you
can use the Text Style drop-down list to select a text style.
All the text styles defined in the current drawing are
displayed in the Text Style drop-down list. The default
text style is Standard. You can specify the text height and
text rotation in the Height and Rotation edit boxes. You
can also define the text height by choosing the Height
button. When you choose this button, AutoCAD LT temporarily exits the dialog box and lets you
enter the height value by selecting points on the screen or from the command line. Once you
have defined the height on the screen, the dialog box reappears and the defined text height is
displayed in the edit box. Similarly, you can define the text rotation by choosing the Rotation
button and then selecting points on the screen or by entering the rotation angle at the command
line.

Lock position in block Check box
This check box is selected to lock the position of the attribute, in case of blocks, and to consider
the attribute while adding an action, in case of dynamic blocks. In case blocks are created using
attributes with this check box cleared, a separate grip will be displayed on this attribute using
which you can edit it. In case dynamic blocks are created using attributes, the attributes that were
defined with the Lock position in block check box cleared, will not be considered to be
manipulated with the parameters and actions.

Figure 15-4  The Text Options area
of the Attribute Definition dialog box

Figure 15-3  The Insertion Point area
of the Attribute Definition dialog box
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Note
The text style must be defined before it can be used to specify the text style.

If you select a style that has the height predefined, AutoCAD LT automatically disables the
Height edit box.

If you have selected the Align option from the Justification drop-down list, the Insertion Point
area and the Height and Rotation edit boxes in the Text Options area are disabled.

If you have selected the Fit option from the Justification drop-down list, the Insertion Point area
and the Rotation edit box is disabled. To specify the location of the attribute, choose OK from the
dialog box. AutoCAD LT prompts you to specify the first and second endpoint of the text baseline.
The text will be fit between the two endpoints that you specify.

After you complete the settings in the Attribute Definition dialog
box and choose OK, the attribute tag text is inserted in the
drawing at the specified insertion point. Now, you can use the
BLOCK or WBLOCK commands to select all the objects and
attributes to define a block.

Note
You can use the -ATTDEF command to display dynamic prompt
on the drawing area. The options in the Attribute Definition
dialog box are available through the dynamic prompt too. See
Figure 15-5.

In this example, you will define the following attributes for a computer and then create a block
using the BLOCK command. The name of the block is COMP.

  Mode  Tag name       Prompt          Default value
Constant ITEM   Computer
Preset, Verify MAKE Enter make:   CAD-CIM
Verify PROCESSOR Enter processor type:   Unknown
Verify HD Enter Hard-Drive size:   40 GB
Invisible, Verify RAM Enter RAM:   256 MB

1. Draw the computer, as shown in Figure 15-6. Assume the dimensions, or measure the
dimensions of the computer you are using for AutoCAD LT.

2. Invoke the ATTDEF command. The Attribute Definition dialog box is displayed.

3. Define the first attribute as shown in the preceding table. Select Constant check box in the
Mode area because the mode of the first attribute is constant. In the Tag edit box, enter the

Example 1 General

Figure 15-5  Dynamic prompt
for the -ATTDEF command
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tag name, ITEM. Similarly, enter COMPUTER in the Value edit box. Note that the Prompt
edit box is not available because the mode is constant.

4. In the Insertion Point area, choose the Pick Point button to define the text insertion point.
Select a point below the insertion base point (P1) of the computer to place the text.

5. In the Text Options area, specify the justification, style, height, and rotation of the text.

6. Choose the OK button once you have entered information in the Attribute Definition
dialog box.

7. Press ENTER to invoke the Attribute Definition dialog box again. Enter the mode and
attribute information for the second attribute as shown in the table at the beginning of
Example 1. You need not define the insertion point and text options again. Select the Align
below previous attribute definition check box that is located just below the Insertion Point
area. You will notice that when you select this check box, the Insertion Point and Text
Options areas are not available. Now, choose the OK button. AutoCAD LT places the attribute
text just below the previous attribute text.

8. Similarly, define the remaining attributes also (Figure 15-7).

9. Now, use the BLOCK command to create a block. The name of the block is COMP, and the
insertion point of the block is P1, midpoint of the base. When you select the objects for the
block, make sure you also select the attributes.

Note
The order of prompts is the same as the order of attributes selection.

Figure 15-7  Define attributes below the computer
drawing

Figure 15-6  Drawing for Example 1



15-8                                                                                            AutoCAD LT 2006 for Designers
©

 C
A

D
C

IM
 T

ec
hn

ol
og

ie
s,

 U
S

A
. F

or
 o

nl
in

e 
tr

ai
ni

ng
, c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

EDITING ATTRIBUTE DEFINITION

Using the DDEDIT command, you can edit text and attribute definitions, before you
define the block. After invoking this command, AutoCAD LT will prompt you to Select
an annotation object or [Undo]. If you select an attribute created using the Attribute

Definition dialog box, the Edit Attribute Definition dialog box is displayed and lists the tag
name, prompt, and default value of the attribute (Figure 15-8). You can also invoke the Edit
Attribute Definition dialog box by double-clicking on the attribute definition.

You can enter the new values in the respective edit boxes. Once you have entered the changed
values, choose the OK button in the dialog box. After you exit the dialog box, AutoCAD LT will
continue to prompt you to select another text or attribute object (Attribute tag). If you have
finished editing and do not want to select another attribute object to edit, press ENTER to
return to the Command prompt.

Using the PROPERTIES Palette
The PROPERTIES command has been already discussed in Chapter 4, Working with Drawing
Aids. It can also be used to edit defined attributes. Select the attribute to be modified and
right-click to display a shortcut menu. Choose Properties here and the PROPERTIES palette
is displayed, see Figure 15-9. You will notice that Attribute is displayed in the text box
located at the top of the palette. Also, under the Categorized tab, you will find that all the
properties of the selected attribute are displayed under four headings. They are General, Text,
Geometry, and Misc. You can change these values in their corresponding fields. For example,
you can modify the color, layer, linetype, thickness, linetype scale, and so on, of the selected
attribute under the General head. Similarly, you can modify the tag name, prompt, and value of
the selected attribute in the Tag, Prompt, and Value fields under the Text heading. Under the
Text head, you can also modify the text style, justification, text height, rotation angle, width
factor, and obliquing angle values of the selected attribute.

Under the Geometry heading, you can redefine the insertion point of the selected attribute by
choosing the button with an arrow icon, which is displayed when you select the Position X,
Position Y, or Position Z fields. When you choose the button with the arrow icon, you are

Figure 15-8  The Edit Attribute Definition dialog box

Toolbar: Text > Edit
Menu: Modify > Object > Text > Edit
Command: DDEDIT
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allowed to reposition an existing insertion point by selecting
on the screen. You can also determine if you want the attribute
text to appear upside down or backwards or not under the
Misc heading. Here, you can also modify the attribute modes,
which have been already defined. When you select a particular
mode, say Invisible, a drop-down list is available in the
corresponding field. This list displays two options, Yes and
No. If you select Yes, the attribute is made invisible and if
you select No, the attribute is not made invisible. To select
a particular mode, you should choose Yes from their
corresponding drop-down lists.

Note
Remember that if you change the justification of the first
attribute below which you have aligned the remaining
attributes, the remaining attributes are not updated
automatically. You will have to change the justifications
of the remaining attributes individually to align them
below the first attribute.

If you change the justification of the attributes from align
to some other, the size of the text is also changed.

You can also use the CHANGE command to edit the
attribute objects using the Command line.

INSERTING BLOCKS WITH ATTRIBUTES
The value of the attributes can be specified during block insertion, either at the command line
or in the Enter Attributes dialog box. When you use the INSERT command or the -INSERT
command to insert a block in a drawing (discussed earlier in Chapter 14, Working with Blocks),
and after you have specified the insertion point, scale factors, and rotation angle, the Enter
Attributes dialog box (Figure 15-10) is displayed, if the system variable ATTDIA is set to 1.

The default value for ATTDIA is 0, which disables the dialog box. The prompts and their
default values, which you had specified with the attribute definition, are then displayed on the
command line after you have specified the insertion point, scale, and rotation angle for the
block to be inserted.

In the Enter Attributes dialog box, the prompts that were entered at the time of attribute
definition in the dialog box are displayed with their default values in the corresponding fields.
If an attribute has been defined with the Constant mode, it is not displayed in the dialog box
because a constant attribute value cannot be edited. You can enter the attribute values in the
fields located next to the attribute prompt. If no new values are specified, the default values are
displayed. Eight attribute values are displayed at a time in the dialog box. If there are more
attributes, they can be accessed by using the Next or Previous buttons. The block name is

Figure 15-9  The PROPERTIES
palette to modify attributes
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Example 2 General

Figure 15-10  The Enter Attributes dialog box

displayed at the top of the dialog box. After entering the new attribute values, choose the OK
button. AutoCAD LT will place these attribute values at the specified location.

Tip
It is more convenient to use the Edit Attributes dialog box because you can view all the
attribute values at a glance and can correct them before placing. Therefore, it is a good idea to
set the ATTDIA value to 1, before you insert a block with attributes.

Attributes can also be defined from the command line by setting the system variable ATTDIA
to 0 (default value). Now, when you use the INSERT command, AutoCAD LT does not
display the Enter Attributes dialog box. Instead, AutoCAD LT prompts you to enter the
attribute values for various attributes that have been defined in the block at the pointer input.

In this example, you will insert the block (COMP) that was defined in Example 1. The following
is the list of the attribute values for computers.

ITEM MAKE PROCESSOR HD RAM
Computer Gateway 486-60 150 MB 16 MB
Computer Zenith 486-30 100 MB 32 MB
Computer IBM 386-30 80 MB 8 MB
Computer Del 586-60 450 MB 64 MB
Computer CAD-CIM Pentium-90 100 Min 32 MB
Computer CAD-CIM Unknown 600 MB Standard

1. Draw the floor plan drawing, as shown in Figure 15-11 (assume the dimensions).
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Figure 15-12  The floor plan after inserting blocks and defining
their attributes

2. Set the system variable ATTDIA to 1. Use the INSERT command to insert the blocks.
When you invoke the INSERT command, the Insert dialog box is displayed. Enter COMP
in the Name edit box and choose OK to exit the dialog box. Select an insertion point on
screen to insert the block. After you specify the insertion point, the Enter Attributes dialog
box is displayed, where you can change the attribute values, if you need to, in the different
edit boxes.

3. Repeat the INSERT command to insert other blocks, and define their attribute values, as
shown in Figure 15-12.

4. Save the drawing for further use.

Figure 15-11  Floor plan drawing for Example 2
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Figure 15-13  The Attribute Extraction dialog box

ATTEXT COMMAND FOR ATTRIBUTE EXTRACTION

The ATTEXT command allows you to use the Attribute Extraction dialog box (Figure 15-13)
for extracting the attributes. The information about the File format, Template file, and Output
file must be entered in the dialog box to extract the defined attribute. Also, you must select the
blocks whose attribute values you want to extract. If you do not specify a particular block, all the
blocks in the drawing are used.

File Format Area
This area of the dialog box lets you select the file format. You can select either of the three radio
buttons available in this area. They are Comma Delimited File (CDF), Space Delimited File
(SDF), and DXF Format Extract File (DXX). The format selection is determined by the application
that you plan to use to process data. Both CDF and SDF formats can be used with the database
software. All of these formats are printable.

Comma Delimited File (CDF). When you select this radio button, the extracted attribute
information is displayed in a CDF format. Here, each character field is enclosed in single
quotes, and the records are separated by a delimiter (comma by default). A CDF file is a text file
with the extension .txt. Of the three formats available, this is the most cumbersome.

Space Delimited File (SDF). In SDF format, the records are of fixed width as specified in the
template file. The records are separated by spaces and the character fields are not enclosed in
single quotes. The SDF file is a text file with the extension .txt. This file format is the most
convenient and easy to use.

DXF Format Extract File (DXX). If you select this file format, you will notice that the Template
File button and edit box in the Attribute Extraction dialog box are not available. This is
because extraction in this file format does not require any template. The file created by this

Command: ATTEXT
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option contains only block references, attribute values, and end-of-sequence objects. This is the
most complex of the three file formats available and is related to programming. The extension
of these files is .dxx.

Select Objects
Select the blocks with attributes whose attribute information you want to extract. You can use any
object selection method. Once you have selected the blocks that you want to use for attribute
extraction, right-click or press ENTER. The Attribute Extraction dialog box is redisplayed and
the number of objects you have selected is displayed adjacent to Number found.

Template File
When you choose the Template File button, the Template File dialog box is displayed, where
you are allowed to select a template file that has been defined already. After you have selected a
template file, choose the Open button to return to the Attribute Extraction dialog box. The
name of the selected file is displayed in the Template File edit box. The template file is saved
with the extension of the file as .txt. The following are the fields that you can specify in a
template file (the comments given on the right are for explanation only; they must not be
entered with the field description):

BL:LEVEL Nwww000 (Block nesting level)
BL:NAME Cwww000 (Block name)
BL:X Nwwwddd (X coordinate of block insertion point)
BL:Y Nwwwddd (Y coordinate of block insertion point)
BL:Z Nwwwddd (Z coordinate of block insertion point)
BL:NUMBER Nwww000 (Block counter)
BL:HANDLE Cwww000 (Block’s handle)
BL:LAYER Cwww000 (Block insertion layer name)
BL:ORIENT Nwwwddd (Block rotation angle)
BL:XSCALE Nwwwddd (X scale factor of block)
BL:YSCALE Nwwwddd (Y scale factor of block)
BL:ZSCALE Nwwwddd (Z scale factor of block)
BL:XEXTRUDE Nwwwddd (X component of block’s extrusion direction)
BL:YEXTRUDE Nwwwddd (Y component of block’s extrusion direction)
BL:ZEXTRUDE Nwwwddd (Z component of block’s extrusion direction)
Attribute tag (The tag name of the block attribute)

The extract file may contain several fields. For example, the first field might be the item name
and the second field might be the price of the item. Each line in the template file specifies one
field in the extract file. Any line in a template file consists of the name of the field, the width of
the field in characters, and its numerical precision (if applicable). For example:
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ITEM            N015002
BL:NAME      C015000

Where BL:NAME ------ Field name
Blankspaces ---- Blank spaces (must not include the tab character)
C ------------------ Designates a character field
N ------------------ Designates a numerical field
015 ---------------- Width of field in characters
002 ---------------- Numerical precision

BL:NAME
or ITEM Indicates the field names; can be of any length.

C Designates a character field; that is, the field contains characters or
it starts with characters. If the file contains numbers or starts with
numbers, then C will be replaced by N. For example, N015002.

015 Designates a field that is fifteen characters long.

002 Designates the numerical precision. In this example, the numerical
precision is 2, or two places following the decimal. The decimal point
and the two digits following the decimal are included in the field
width. In the next example, (000), the numerical precision, is not
applicable because the field does not have any numerical value (the
field contains letters only).

After creating a template file, when you choose the Template File button, the Template File
dialog box is displayed, where you can browse and select a template file (Figure 15-14).

Note
You can put any number of spaces between the field name and the character C or N (ITEM
N015002). However, you must not use the tab characters. Any alignment in the fields must be
done by inserting spaces after the field name.

In the template file, a field name must not appear more than once. The template file name and the
output file name must be different.

The template file must contain at least one field with an attribute tag name because the tag names
determine which attribute values are to be extracted and from which blocks. If several blocks
have different block names but the same attribute tag, AutoCAD LT will extract attribute values
from all the selected blocks. For example, if there are two blocks in the drawing with the attribute
tag PRICE, then when you extract the attribute values, AutoCAD LT will extract the value from
both blocks (if both blocks were selected). To extract the value of an attribute, the tag name must
match the field name specified in the template file. AutoCAD LT automatically converts the tag
names and the field names to uppercase letters before making a comparison.
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Output File
When you choose the Output File button, the Output File dialog box is displayed. You can
select an existing file here, if you want the extracted or output file to be saved as an existing file.
You can enter a name in the File Name edit box in the Output File dialog box (Figure 15-15)
and then choose the Save button, if you want to save the output file as a new file. By default, the
output file has the same name as the drawing name. For example, a drawing named Drawing1.dwg
will have an output file by the name Drawing1.txt by default. Once a name for the output file is
specified, it is displayed in the Output File edit box in the Attribute Extraction dialog box. You
can also enter the file name in this edit box. As discussed earlier, AutoCAD LT appends .txt file
extension for CDF or SDF files and .dxx file extension for DXF files.

Note
You can also use the -ATTEXT command to extract attributes using the command line. Here,
you are prompted to specify a file format for the extract information and you can also select
specific blocks to extract their attribute information. You can specify a template file using the
Select Template File dialog box and an extract file using the Create extract file dialog box.

Figure 15-14  The Template File dialog box to select a template file
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Figure 15-15  The Output File dialog box to save an output file

Example 3 General

In this example, you will extract the attribute values that were defined in Example 2. Extract the
values of MAKE, PROCESSOR, HD, and RAM. These attribute values must be saved in a Tab
Delimited File named TEST and arranged, as shown in the following table.

     COMP    1  Gateway 486-60 150 MB 16 MB             Computer
COMP    1  Zenith 486-30 100 MB 32 MB Computer
COMP    1  IBM 386-30 80 MB 8 MB Computer
COMP    1  Del 586-60 450 MB 64 MB Computer
COMP    1  CAD-CIM Pentium-90 100 Min 32 MB Computer
COMP    1  CAD-CIM Unknown 600 MB Standard Computer

1. Open the drawing you saved in Example 2.

2. Use the ATTEXT command to invoke the Attribute Extraction wizard. Select the Select
Objects radio button from the Select Drawing page. Choose Select Objects button and
select the objects in the current drawing whose attributes have to be extracted. After selecting,
choose the Next button.

3. In the Settings page, clear both the check boxes of Xrefs and Nested blocks since there are
no external references and nested blocks. Choose the Next button.
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4. In the Use Template page, select the No template radio button and choose Next.

5. In the Select Attributes page, select the check box named COMP from the Blocks area. In
the attribute list, clear all the check boxes and then select the MAKE, PROCESSOR, HD,
RAM, and ITEM check boxes. Choose the Next button.

6. The View output page shows the result of your query. Here, choose the view you want for
the data to be displayed in an exported file. Choose the Next button.

7. In the Save template page, choose the Next button.

8. In the Export page, enter the name of the output file, TEST, and save it in Tab Delimited
File format. Choose the Finish button.

9. You can view the resultant output file in the Notepad. Open the Notepad using the Start
menu and then specify the location of the Test.txt file. The output file will be similar to the
file shown at the beginning of Example 3.

CONTROLLING ATTRIBUTE VISIBILITY

The ATTDISP command allows you to change the visibility of all attribute values. Normally, the
attributes are visible unless they are defined invisible by using the Invisible mode. The invisible
attributes are not displayed, but they are a part of the block definition. You can select any one of
the options of the ATTDISP command to turn the display of the attributes completely on or off.
You can also select the Normal option, where the attributes that were created using the Invisible
mode continue to be invisible. The options can be selected from the View > Display >
Attribute Display cascading menu. You can also enter ATTDISP at the pointer input or at the
command line. The prompt sequence for the command is given next.

Command: ATTDISP
Enter attribute visibility setting [Normal/ON/OFF] <Normal>: Specify an option and press
ENTER.

When you select ON, all attribute values will be displayed, including the attributes that are
defined with the Invisible mode. If you select OFF, all attribute values will become invisible.
Similarly, if you select N (Normal), AutoCAD LT will display the attribute values the way they are
defined, that is, the attributes that were defined invisible will stay invisible and the attributes that
were defined visible are visible.

In Example 2, the RAM attribute was defined with the Invisible mode. Therefore, the RAM
values are not displayed with the block. If you want to make the RAM attribute values visible
(Figure 15-16), choose On from the View > Display > Attribute Display menu.

Menu: View > Display > Attribute Display
Command: ATTDISP



15-18                                                                                            AutoCAD LT 2006 for Designers
©

 C
A

D
C

IM
 T

ec
hn

ol
og

ie
s,

 U
S

A
. F

or
 o

nl
in

e 
tr

ai
ni

ng
, c

on
ta

ct
 s

al
es

@
ca

dc
im

.c
om

Figure 15-16  Using the ATTDISP command to make the RAM
attribute values visible

Toolbar: Modify II > Edit Attribute
Menu: Modify > Object > Attribute > Single
Command: ATTEDIT

Tip
After you have defined the attribute values and saved them with the block definition, it may be
a good idea to use the Off option of the ATTDISP command. By doing this, the drawing is
simplified and also regeneration time is reduced.

EDITING BLOCK ATTRIBUTES
You can edit single block at a time using the dialog box or can edit more than one blocks at a
time. Both the methods of editing the attribute value are discussed next.

Editing Attributes Using the Edit Attributes Dialog Box

The ATTEDIT command allows you to edit the block attribute values through the
Edit Attributes dialog box. Invoke this command; AutoCAD LT prompts you to select
the block whose values you want to edit. After selecting the block, the Edit Attributes

dialog box (Figure 15-17) is displayed.

The dialog box is similar to the Enter Attributes dialog box and shows the prompts and the
attribute values of the selected block. If an attribute has been defined with the Constant mode, it
is not displayed in the dialog box because a constant attribute value cannot be edited. To make
any changes, select the existing value and enter a new value in the corresponding edit box. After
you have made the modifications, choose the OK button. The attribute values are updated in the
selected block.
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If a selected block has no attributes, AutoCAD LT will display the alert message That block has
no editable attributes. Similarly, if the selected object is not a block, AutoCAD LT again displays
the alert message That object is not a block.

Note
You cannot use the ATTEDIT command to perform global editing of attribute values, or to
modify position, height, or style of the attribute value. The global editing can be performed using
the -ATTEDIT command, which is discussed in the next section.

In this example, you will use the ATTEDIT command to change the attribute of the first computer

(150 MB to 2.1 GB), which is located in Room-1.

1. Open the drawing that was created in
Example 2. The drawing has six blocks
with attributes. The name of the block is
COMP, and it has five defined attributes,
one of them invisible. Zoom in so that
the first computer is displayed on the
screen (Figure 15-18).

2. Invoke the ATTEDIT command.
AutoCAD LT will prompt you to select a
block. Select the computer located in
Room-1.

Figure 15-17  Editing attribute values using the Edit Attributes dialog box

Example 4 General

Figure 15-18  Zoomed view of the first computer
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AutoCAD LT will display the Edit Attribute dialog box (Figure 15-31) that shows the attribute
prompts and the attribute values.

3. Edit the values, select Apply, and choose the OK button in the dialog box. When you exit
the dialog box, the attribute values are updated.

Tip
You can also edit attributes with the FIND command. This command can be invoked by
entering FIND at the pointer input. When you invoke this command, the Find and Replace
dialog box is displayed.

When you know that a set of attributes in a drawing may have to be changed in the future, you
can make a group out of them by using the GROUP command. Then later you can choose the
Select objects button in the Find and Replace dialog box and enter G at the Select objects
prompt and enter the name of the group. All the objects in the group will get selected.

Global Editing of Attributes

The -ATTEDIT command allows you to edit the attribute values independently of the blocks
that contain the attribute reference. For example, if there are two blocks, COMPUTER and
TABLE, with the attribute value PRICE, you can globally edit this value (PRICE) independently
of the block that references these values. You can also edit the attribute values one at a time. For
example, you can edit the attribute value (PRICE) of the block TABLE without affecting the value
of the other block, COMPUTER. When you enter the -ATTEDIT command, AutoCAD LT
displays the following prompt:

Command: -ATTEDIT
Edit attributes one at a time? [Yes/No]: N
Performing global editing of attribute values

If you enter N at this prompt, it means that you want to do the global editing of the attributes.
However, you can restrict the editing of attributes by block names, tag names, attribute values,
and visibility of attributes on the screen.

Editing Visible Attributes Only
After you select global editing, AutoCAD LT will display the following prompt:

Edit only attributes visible on screen? [Yes/No] <Y>: Y

If you enter Y at this prompt, AutoCAD LT will edit only those attributes that are visible and
displayed on the screen. The attributes might not have been defined with the Invisible mode,
but if they are not displayed on the screen, they are not visible for editing. For example, if you
zoom in, some of the attributes may not be displayed on the screen. Since the attributes are not
displayed on the screen, they are invisible and cannot be selected for editing.

Menu: Modify > Object > Attribute >Global
Command: -ATTEDIT
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Editing All Attributes
If you enter N at the previously mentioned prompt, AutoCAD LT flips from graphics to text
screen and displays the following message on the screen:

Drawing must be regenerated afterwards.

Now, AutoCAD LT will edit all attributes even if they are not visible or displayed on the
screen. Also, changes that you make in the attribute values are not reflected immediately. Instead, the
attribute values are updated and the drawing is regenerated after you are done with the command.

Editing Specific Blocks
Although you have selected global editing, you can confine the editing of attributes to specific
blocks by entering the block name at the prompt. For example

Enter block name specification <*>: COMP

When you enter the name of the block, AutoCAD LT will edit the attributes that have the given
block (COMP) reference. You can also use the wild-card characters to specify the block names. If
you want to edit attributes in all blocks that have attributes defined, press ENTER.

Editing Attributes with Specific Attribute Tag Names
Like blocks, you can confine attribute editing to those attribute values that have the specified tag
name. For example, if you want to edit the attribute values that have the tag name MAKE, enter
the tag name at the following AutoCAD LT prompt.

Enter attribute tag specification <*>: MAKE

When you specify the tag name, AutoCAD LT will not edit attributes that have a different tag
name, even if the values being edited are the same. You can also use the wild-card characters to
specify the tag names. If you want to edit attributes with any tag name, press ENTER.

Editing Attributes with a Specific Attribute Value
Like blocks and attribute tag names, you can confine attribute editing to a specified attribute
value. For example, if you want to edit the attribute values that have the value 100 MB, enter the
value at the following AutoCAD LT prompt.

Enter attribute value specification <*>: 100MB

When you specify the attribute value, AutoCAD LT will not edit attributes that have a different
value, even if the tag name and block specification are the same. You can also use the
wild-card characters to specify the attribute value. If you want to edit attributes with any value,
press ENTER.

Sometimes the value of an attribute is null, and these values are not visible. If you want to select
the null values for editing, make sure you have not restricted the global editing to visible attributes.
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To edit the null attributes, enter \ at the following prompt.

Enter attribute value specification <*>: \

After you enter this information, AutoCAD LT will prompt you to select the attributes. You can
select the attributes by selecting individual attributes or by using one of the object selection
options (Window, Crossing, or individually).

Select Attributes: Select the attribute values parallel to the current UCS only.

After you select the attributes, AutoCAD LT will prompt you to enter the string you want to
change and the new string. A string is a sequence of consecutive characters. It could also be a
portion of the text. AutoCAD LT will retrieve the attribute information, edit it, and then update
the attribute values.

Enter string to change: Enter the value which is to be modified.
Enter new string: Enter the new value.

The following is the complete command prompt sequence of the -ATTEDIT command. It is
assumed that the editing is global and for visible attributes only.

Command: -ATTEDIT
Edit attributes one at a time? [Yes/No] <Y>: N
Performing global editing of attribute values.
Edit only attributes visible on screen? [Yes/No] <Y>: N
Drawing must be regenerated afterwards.
Enter block name specification <*>: �
Enter attribute tag specification <*>: �
Enter attribute value specification <*>: �
Enter string to change: Enter the value to be modified.
Enter new string: Enter the new value.

Note
AutoCAD LT regenerates the drawing at the end of the command automatically unless system
variable REGENAUTO is off, which controls automatic regeneration of the drawing.

If you select an attribute defined with the Constant mode using the -ATTEDIT command,
prompt displays 0 found, since attributes with constant mode is uneditable.

In this example, you will use the drawing from Example 2 to edit the attribute values that are
highlighted in the following table. The tag names are given at the top of the table (ITEM,
MAKE, PROCESSOR, HD, RAM). The RAM values are invisible in the drawing.

Example 5 General
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  ITEM   MAKE        PROCESSOR   HD  RAM
COMP Computer Gateway 486-60 150 MB 16 MB
COMP Computer Zenith 486-30 100 MB 32 MB
COMP Computer IBM 386-30 80 MB 8 MB
COMP Computer Del 586-60 450 MB 64 MB
COMP Computer CAD-CIM Pentium-90 100 Min 32 MB
COMP Computer CAD-CIM Unknown 600 MB Standard

Make the following changes in the highlighted attribute values (Figure 15-19).

1. Change Unknown to Pentium.

2. Change CAD-CIM to Compaq.

3. Change MB to Meg for all attribute values that have the tag name RAM. (No changes should
be made to the values that have the tag name HD.)

The following is the prompt sequence to change the attribute value from Unknown to Pentium.

1. Enter the -ATTEDIT command at the Command prompt. At the next prompt, enter N  and
press ENTER.

Command: -ATTEDIT
Edit attributes one at a time? [Yes/No] <Y>: N
Performing global editing of attribute values.

2. We want to edit only those attributes that are visible on the screen, so press ENTER at the
following prompt:

Figure 15-19  Using -ATTEDIT to change the attribute values
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Edit only attributes visible on screen? [Yes/No] <Y>: �

3. As shown in the table, the attributes belong to a single block, COMP. In a drawing, there
could be more blocks. To confine the attribute editing to the COMP block only, enter the
name of the block (COMP) at the next prompt.

Enter block name specification <*>: COMP

4. At the next two prompts, enter the attribute tag name and the attribute value specification.
When you enter these two values, only those attributes that have the specified tag name and
attribute value will be edited.

Enter attribute tag specification<*>: Processor
Enter attribute value specification<*>: Unknown

5. Next, AutoCAD LT will prompt you to select attributes. Use any object selection option to
select all the blocks. AutoCAD LT will search for the attributes that satisfy the given criteria
(attributes belong to the block COMP, the attributes have the tag name Processor, and the
attribute value is Unknown). Once AutoCAD LT locates such attributes, they will be
highlighted.

6. At the next two prompts, enter the string you want to change, and then enter the new string.

Enter string to change: Unknown
Enter new string: Pentium

7. The following is the Command prompt sequence to change the make of the computers from
CAD-CIM to Compaq.

Command: -ATTEDIT
Edit attributes one at a time? [Yes/No] <Y>: N
Performing global editing of attribute values.
Edit only attributes visible on screen? [Yes/No] <Y>: �
Enter block name specification <*>: COMP
Enter attribute tag specification <*>: MAKE
Enter attribute value specification <*>: �
Select Attributes: Use any selection method to select the attributes.
n attributes selected.
Select Attributes: �
Enter string to change: CAD-CIM
Enter new string: Compaq

8. The following is the Command prompt sequence to change MB to Meg.
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Command: -ATTEDIT
Edit attributes one at a time? [Yes/No] <Y>: N
Performing global editing of attribute values.

At the next prompt, you must enter N because the attributes you want to edit (tag name,
RAM) are not visible on the screen.

Edit only attributes visible on screen? [Yes/No] <Y>: N
Drawing must be regenerated afterwards.
Enter block name specification <*>: COMP

At the next prompt, about the tag specification, you must specify the tag name because the
text string MB also appears in the hard drive size (tag name, HD). If you do not enter the
tag name, AutoCAD LT will change all MB attribute values to Meg.

Enter attribute tag specification <*>: RAM
Enter attribute value specification <*>:
n Attributes selected
Enter string to change: MB
Enter new string: Meg

9. Choose On from the View > Display > Attribute Display menu to display the invisible
attributes on the screen.

Note
You can also use the -ATTEDIT command to edit the attribute values individually. Attribute
value, string, position, height, angle, layer, and color can be changed using this command.

In this example, you will use the drawing in Example 5 to edit the attributes individually
(Figure 15-20). Make the following changes in the attribute values.

a. Change the attribute value 100 Min to 100 MB.
b. Change the height of all attributes with the tag name RAM to 0.075 units.

1. Load the drawing that you had saved in Example 5.

2. At the AutoCAD LT Command prompt, enter the -ATTEDIT command. The following is
the command prompt sequence to change the value of 100 Min to 100 MB.

Command: -ATTEDIT
Edit attributes one at a time? [Yes/No] <Y>: �
Enter block name specification <*>: COMP
Enter attribute tag specification <*>: �
Enter attribute value specification <*>: �

Example 6 General
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Select Attributes: Select the attribute.
Enter an option [Value/Position/Height/Angle/Style/Layer/Color/Next] <N>: V
Enter type of value modification [Change/Replace] <R>: C
Enter string to change: \ Min
Enter new string: 100MB

When AutoCAD LT prompts Enter string to change:, enter the characters you want to
change. In this example, the characters Min are preceded by a space. If you enter a space,
AutoCAD LT displays the next prompt, Enter new string. If you need a leading blank
space, the character string must start with a backslash (\), followed by the desired number of
blank spaces.

3. To change the height of the attribute text, enter the -ATTEDIT command as just shown.
When AutoCAD LT displays the following prompt, enter H for height.

Enter an option [Value/Position/Height/Angle/Style/Layer/Color/Next] <N>: H
Specify new height <current>: 0.075

After you enter the new height and press ENTER, AutoCAD LT will change the height of
the text string that has the X mark. AutoCAD LT will then repeat the last prompt. Use the
Next option to move the X mark to the next attribute. To change the height of other
attribute values, repeat these steps. The drawing after editing the attributes is shown in
Figure 15-20.

4. Repeat Steps 2 and 3 to change the height of the other attribute values.

Figure 15-20  Using -ATTEDIT to change the attribute values individually
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Tip
When you are defining attributes and have certain attributes whose values are not known at
that time, you should enter AAAA or something similar. Later on you can replace such text
with the values that you have obtained, using the ATTEDIT or -ATTEDIT commands. This
is easier than adding an attribute later after the block has already been defined.

INSERTING TEXT FILES IN THE DRAWING

After you have extracted attribute information into a file, you may want to insert this text
into a drawing. You can insert this text file in a drawing by using the Import Text
option that is displayed when you right-click in the text window of the In-Place Text

Editor. The In-Place Text Editor is displayed using the MTEXT command.

After you have invoked the MTEXT command, AutoCAD LT prompts you to enter the insertion
point and other corner of the paragraph text box, within which the text file will be placed.  After
you specify these points, the In-Place Text Editor is displayed. To insert the text file Test.txt
(created in Example 3), right-click in the text window of the In-Place Text Editor to display the
shortcut menu. In this shortcut menu, choose Import Text. AutoCAD LT displays the Select
File dialog box.

In the Select File dialog box, you can select the text file Test from the list box and then choose
the Open button. The imported text is displayed in the text window of the In-Place Text Editor
(Figure 15-21). Note that only the ASCII files are properly interpreted. Now choose the OK
button to get the imported text in the selected area on the screen (Figure 15-22).

You can also use the In-Place Text Editor to change the text style, height, direction, width,
rotation, line spacing, and attachment.

Toolbar: Draw > Multiline Text
Text > Multiline Text

Menu: Draw > Text > Multiline Text
Command: MTEXT

Figure 15-21  The In-Place Text Editor displaying the imported text
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Answer the following questions, and then compare your answers to those given at the end of
this chapter.

1. Like a constant attribute, the Preset attribute cannot be edited.  (T/F)

2. For tag names, any lowercase letters are automatically converted to uppercase.  (T/F)

3. You can use the ATTEDIT command to modify the justification, height, or style of the
attribute value.  (T/F)

4. If you select the On option of the ATTDISP command, even the attributes defined with the
Invisible mode are displayed. (T/F)

5. The entry in the Value edit box of the Attribute Definition dialog box defines the __________
of the specified attribute.

6. If you have selected the Align option from the Justification drop-down list, in the Text
Options area of the Attribute Definition dialog box, the Height and Rotation edit boxes
are __________.

7. You can use the __________, and  __________ commands or the PROPERTIES palette to
edit text or attribute definitions.

8. The default value of the ATTDIA variable is __________, which disables the dialog box.

9. In the __________ File, the records are not separated by a comma and the character fields
are not enclosed in single quotes.

10. The __________ command is ued to redefine an existing block with attributes in a drawing and
once redefined, all the copies of the block in the drawing are updated.

Figure 15-22  Imported text file on the screen

Self-Evaluation Test
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Answer the following questions.

1. If you do not enter anything in the Prompt edit box, the entry made in the Tag edit box is
used as the prompt.  (T/F)

2. You can also use the Find and Replace dialog box to modify the attribute values. (T/F)

3. The Constant mode lets you define an attribute that has a constant value and cannot be
edited later. (T/F)

4. You can use ? and * in the string value. When these characters are used in string values,
AutoCAD LT does not interpret them as wild-card characters.  (T/F)

5. The template file name and the output file name can be the same. (T/F)

6. Not selecting any of the check boxes in the Mode area of the Attribute Definition dialog
box displays all the prompts at the command line and the values will be visible on the
screen. This is also referred to as which mode?

(a) Formal (b) Normal
(c) Abnormal (d) None of the above

7. Which of the following system variables when set to 0 will suppress the display of prompts
for new values?

(a) ATTDIA (b) ATTREQ
(c) ATTMODE (d) ATTDEF

8. Selecting the Off option of which command turns off the visibility of all attribute values?

(a) ATTDISP (b) ATTEXT
(c) ATTEDIT (d) ATTDEF

9. AutoCAD LT regenerates the drawing at the end of the -ATTEDIT command, unless which
of the following is turned off?

(a) AUTOSNAP (b) REGENAUTO
(c) ATTDIA (d) ATTMODE

10. If you need a leading blank space in the string to be changed, the character string must start
with which one of the following characters?

(a) space ( ) (b) backlash (\)
(c) asterisk (*) (d) colon (:)

Review Questions
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11. You can insert the text file in the drawing by choosing the __________ button in the In-Place
Text Editor displayed when using the MTEXT command.

12. The function of the Preset option is ___________________________________.

13. If you select the Constant check box in the Mode area of the Attribute Definition dialog
box, the Prompt edit box is __________.

14. You should select the __________ check box in the Attribute Definition dialog box to
automatically place the subsequent attribute text just below the previously defined attribute.

15. The attribute extract file is saved as a __________ file.

In this exercise, you will define the following attributes for a resistor and then create a block
using the BLOCK command. The name of the block is RESIS.

Mode Tag name   Prompt Default value
Verify  RNAME Enter name         RX
Verify  RVALUE Enter resistance         XX
Verify, Invisible  RPRICE Enter price         00

1. Draw the resistor, as shown in Figure 15-23.

2. Enter ATTDEF at the AutoCAD LT Command prompt to invoke the Attribute Definition
dialog box.

3. Define the attributes, as shown in the preceding table, and position the attribute text as
shown in Figure 15-23.

4. Use the BLOCK command to create a block. The name of the block is RESIS, and the
insertion point of the block is at the left end of the resistor. When you select the objects for
the block, make sure you also select the attributes.

Exercise 1 Electronics

Exercises
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In this exercise, you will use the INSERT command to insert the block that was defined in
Exercise 1 (RESIS). The following is the list of the attribute values for the resistances in the
electric circuit.

RNAME RVALUE RPRICE
    R1      35    0.32
    R2      27    0.25
    R3      52    0.40
    R4        8    0.21
    RX      10    0.21

1. Draw the electric circuit diagram, as shown in Figure 15-24 (assume the dimensions).

2. Set the system variable ATTDIA to 1. Use the INSERT command to insert the blocks, and
define the attribute values in the Enter Attributes dialog box.

3. Repeat the INSERT command to insert other blocks, and define their attribute values as
given in the table. Save the drawing as attexr2.dwg (Figure 15-25).

Figure 15-23  Drawing of a resistor for Exercise 1

Exercise 2 Electronics
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In this example, you will extract the attribute values that were defined in Exercise 2. Extract the
values of RNAME, RVALUE, and RPRICE. These attribute values must be saved in a Tab Delimited
File format named RESISLST and arranged, as shown in the following table.

RESIS       1 R1 35 0.32
RESIS       1 R2 27 0.25
RESIS       1 R3 52 0.40
RESIS       1 R4 8 0.21
RESIS       1 RX 10 0.21

1. Load the drawing ATTEXR2 that you saved in Exercise 2.

2. Use the ATTEXT command to invoke the Attribute Extraction wizard, and select the
Select Objects radio button. Now, choose Select Objects button and select the objects in
the current drawing, whose attributes have to be extracted. Now, choose Next in the wizard.

3. On the Settings page, clear both the check boxes of Xrefs and Nested blocks and choose
Next.

4. On the Use Template page, select the No Template radio button and choose Next.

5. On the Select Attribute page, under the Block Name heading, select the check box named
RESIS. In the attribute list, clear all the check boxes and select RNAME, RVALUE, and
RPRICE check boxes. Choose Next.

6. View output page shows the result of your query. Here, choose the view you want the data to
be displayed in the exported file. Select the Next button.

7. Ignore the Save template page and choose Next.

Figure 15-25  Electric circuit diagram with
resistors for Exercise 2

Figure 15-24  Electric circuit diagram without
resistors for Exercise 2

Exercise 3 Electronics
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8. On the Export page, enter the name of the output file, RESISLST, and save it in Tab
Delimited File format. Choose Finish. Use Notepad to list the output file, RESISLST. The
output file will be similar to the file shown at the beginning of Exercise 3.

In this exercise, you will use the ATTEDIT command to change the attributes of the resistances
that are highlighted in the following table. You will also extract the attribute values and insert the
text file in the drawing.

1. Load the drawing ATTEXR2 that was created in Exercise 2. The drawing has five resistances
with attributes. The name of the block is RESIS, and it has three defined attributes, one of
them invisible.

2. Use the ATTEDIT command to edit the values that are highlighted in the following table.

RESIS R1 40 0.32
RESIS R2 29 0.25
RESIS R3 52 0.45
RESIS R4 8 0.25
RESIS R5 10 0.21

3. Extract the attribute values, and write the values to a text file.

4. Use the MTEXT command to insert the text file in the drawing.

Use the information given in Exercise 3 to extract the attribute values, and write the data to the
output file. The data in the output file should be Comma Delimited CDF. Use the ATTEXT and
-ATTEXT commands to extract the attribute values.

In this exercise, you will create the blocks with the required attributes. Next, draw the circuit
diagram shown in Figure 15-26 and then extract the attributes to create a bill of materials.

Exercise 4 Electronics

Exercise 5 Electronics

Exercise 6 Electronics
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Figure 15-26  Drawing of the circuit diagram for Exercise 6
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Figure 15-27  Drawing for Exercise 7

Exercise 7 Electronics

In this exercise, you will create the blocks with the required attributes. Next, draw the circuit
diagram shown in Figure 15-27 and then extract the attributes to create a bill of materials.
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Answers to Self-Evaluation Test
1 - F, 2 - T, 3 - T, 4 - T,  5 - default value, 6 - disabled, 7 - EATTEDIT, CHANGE, 8 - 0,
9 - Space Delimited, 10 - ATTREDEF


